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Ramblers’ Association  Lancaster Group 

Lost Ways Exercises on MARIO 

LESSON 1 

 

This ‘WORD’ document (‘Lost Ways MARIO exercise MOOC.doc’) should be loaded on your computer 

and left open.  We will use it for reference and to rapidly reach specific web pages using your browser.  Just 

click on the url active link [the blue underlined phrase] in the WORD document.    

 

This is a self taught exercise in using MARIO to find historical information to aid in searching for old paths 

which might become public rights of way (footpaths or bridleways).   

 

MARIO is Lancashire County Council’s on-line Graphical Information System (GIS).  It is a very useful 

resource and contains a huge amount of information in map form.  THIS EXERCISE IS ONLY OF VALUE 

FOR WORK IN LANCASHIRE.  However the same work can be done anywhere, but with more difficulty 

since the material may have to be collected from different sources.   

 

Back ground to Lost Ways 

There is a presumption in law that ‘once a highway, always a highway’.  This will stop in 2026 when 

historical claims to put a highway (public right of way (PROW)) on the Definitive Map (the legal register of 

PROW) will no longer be a possible process. This is explained by the Ramblers.    

http://www.ramblers.org.uk/england/campaign-with-us/dont-lose-your-way/historic-paths-and-definitive-

maps-timeline.aspx 

So claims have to be made by then; although it will take many years to work through the many that will be 

submitted in the next few years.   

 

The process is simple since information has just to be sent to the Highway Authority, here Lancashire 

County Council, and they will work on the final details of the case.  However it is necessary to assemble 

enough good evidence that they are willing to continue.   

 

You are likely to make a claim because; you have walked it, it is obvious on the ground (a track), there are 

few paths in that area (probably because powerful landowners were able to block the addition of paths to the 

Definitive Map when these were drawn up) or you have looked at old documents where statements were 

made that there were public rights along a particular route (eg Tithe Maps or Railway Maps or Tax Maps or 

travellers’ diaries).   

 

Historical Claims 

There are two main methods to make a historical claim:  One is public use without question or challenge for 

over 20 years and the second is documentary evidence.  The public use method will not be discussed here 

since it affects few paths and needs different special care; however it may help when added to the 

documentary evidence.   

 

Here we will study the use of the most commonly used maps to find likely paths.  We will not deal here in 

detail with the study of those documents which are very specific to only some routes which have particular 

circumstances, such as Tithe Maps, Wills, Estate Maps, Tax Maps, Railway and Canal Maps etc.  These are 

separate and more complicated studies which can take a long time.   

http://www.ramblers.org.uk/england/campaign-with-us/dont-lose-your-way/historic-paths-and-definitive-maps-timeline.aspx
http://www.ramblers.org.uk/england/campaign-with-us/dont-lose-your-way/historic-paths-and-definitive-maps-timeline.aspx
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A good reference book is ‘Rights of Way- Restoring the Record’ by Sarah Bucks and Phil Wadey, bucks 

and Wadey Publishing2012.   

 

Of course the ‘Blue Book’ [Rights of Way. A Guide to the Law and Pracrtice by John Riddall and John 

Trevelyan, The Ramblers Association and the Open Spaces Society], has lots of legal information.   

 

The use of On-Line maps 

This can be a very rapid process in Lancashire because the County Council has a mass of information on-

line.  We will introduce it here.  Note that it is not always totally accurate since it has been transcribed to the 

on-line maps from paper maps so there may be drawing errors or stretching of the paper maps or simply 

mistakes by the operator.   

 

MARIO 

MARIO is the LCC internet map.  It is full of information.   

Open up MARIO http://mario.lancashire.gov.uk/agsmario/ .   

It can also be found through the LCC web page http://www.lancashire.gov.uk/home/2010/classic/index.asp  

Click ‘Open MARIO’, [or enter the postcode of where you want to look if you know it].   

For now ignore the panel on the left but click your mouse on the map and move it to create a very small 

rectangle roughly where you want to search.  It must be very small to work since the base map is faint and 

has little detail.  Release the button.  If you have hit lucky and it looks like the right place or close by, click 

‘Zoom to point’ on the top row and click at the place where your want to enlarge the map.  If the map is 

about the right size and near the right place, click on ‘Move Map’ and then click and drag the map to the 

right place.  If you have not got near the right place try a new Zoom to box with a new box or some other 

method such as the post code or place name.   

You must reach a scale of better than 1:10,000 [smaller number] or there will not be enough detail (see the 

scale at the right end of red ribbon at the top).  That is normally a good enough scale but further ‘Zoom to 

point’ will get down to each individual building.   

When you are happy click back to ‘Move the Map’ for convenience or otherwise every time you hit the 

mouse button the map will change scale.  Annoying ,but you can recover my using the Previous button.   

 

EXAMPLE 

Just for practice, let’s look at a familiar place just east of Lancaster as an example.  To get there we will use 

another method by entering the grid reference. You might have found this from a paper map.   

On the left panel click the ‘Tools’ tab and then ‘Grid References’ on the list.  Scroll near the top to see 

‘Zoom to Grid References’ and two boxes SD and below this insert 496586.  Click ‘Zoom to Grid 

Reference’.  The red dot is the point. Click ‘Zoom to Point’ and click the red dot a couple of times until the 

map scale in top Right hand corner says better than 1:10,000.  You should get a base map like the one 

below.  [This one in this document is not active, you must use the MARIO version].   

 

Now to view the interesting bits.  On the left panel click ‘maps’ and then, from the list, ‘Countryside, 

Environment and Waste’.  From the map layers which are then offered click the box ‘Public Rights of Way’.  

A disclaimer panel appears but click ‘back to maps’.   

You now have all the footpaths with their numbers.   

http://mario.lancashire.gov.uk/agsmario/
http://www.lancashire.gov.uk/home/2010/classic/index.asp
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On the right of ‘Public Rights of Way’ there is a box with three stripes.   Click it to get a key of the path 

notation.   There is also an ‘i’ in a circle. Click this and then on one of the paths and you get all information 

about it, including its number and Parish.   

 

Leave the footpaths showing on your map.  The next bit of important information is under a different map 

layer ’Highways and Transportation’.   

Click this and then check the box for ‘Road Status’.  Again there is a Key and an information button,.   

This shows major roads, roads adopted by the County and roads not adopted.  Some of these categories may 

not be clear to you; or probably the County Highways since it is said that there are problems.  Your map 

should now look something like this.  Not exactly, since for some reason, this print version does not show 

some things.   

http://mario.lancashire.gov.uk/printing/_printCDF797B1F22D447988BB8035196B839A.png 

 
 

 

 

Let’s look at a few specific features on this map.   

1 Where there is dual status: that is there is a footpath and a road marked (from the two individual 

maps that we have superimposed) then sometimes one or other does not come up.  You can distinguish this 

by switching each category, or layer, on and off with the check button.  The printing image is worse than on-

line.   

 

http://mario.lancashire.gov.uk/printing/_printCDF797B1F22D447988BB8035196B839A.png
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2 A path should legally end on a public road and you can verify this on the display. Sometimes there is 

a gap!   

 

3 On the left part of this example map you can see that there are footways left between houses 

(ginnels).  We walk on these but they are not ‘definitive’ footpaths and have less protection.   

 

 

Now let’s look at historic maps on MARIO.   

To see whether your candidate route for a claim has been around (and possibly used) for a long time we 

need to look on old maps.  This is easy with MARIO.   

Go to layer ‘Aerial Photographs and Historic Maps’.   

Turn off any layer you are not using. This simplifies the picture but you can turn it on again later.   

 

 

1 Now try ‘Aerial Photos’ at different ages one at a time.  There is no 1940’s picture for this area.  

Now you can practice with another feature.  There is a slider called transparency, (sometimes this 

does not function properly, in that case go out of MARIO and try again) If you move this with 

your mouse (click, hold and move) you can change the relative visibility of the base map and the 

layer you are looking at.  You can see both and compare.   

 

2 Now the OS first edition 1:2,500 or 1:10,000 (not the Yorkshire ones which are for the bit of 

Lancashire in the east which we had given to us).   

 

3 There is also a direct copy of the PROW (legal) Definitive map so you can check that the PROW 

layers have been transcribed accurately on to the MARIO footpath layer.  You will see why there 

are problems. The original, and legal, Definitive Map looks as though it was drawn with a felt-tip 

pen and if a gap in the dotted line is at the end of the dashed line then it may appear that the path 

does not reach the road.   

 

These should allow you to study the present paths and the past paths.   

ENJOY 
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LESSON 2 

Explore the range of treats on MARIO 

 

First look at the Maps tab.   

The Map Layers/Settings tells you what information you have loaded on to your map.   

 

The Learning Leisure and Culture tab  

has short and long health walks layers   These walks have few difficult sections.   

 

The Countryside, Environment and Waste tab  

has lots of interesting layers. 

Access Points are easy ways on to Access land.  It is not kept up to date so it is not always accurate.   

We have already played with the Public Rights of Way layer but try the ‘i’ button where you can report a 

problem with the path.   

Access Land is shown and here you can walk freely.   

Highways Act Section 31 is obscure information where landowners have dedicated PROW but in return 

state that there are no others on their land.   

Nature Reserves and Woodland Trust sites are often open to the public.   

Moor and Marshland is just a farming designation.   

 

On the Highways and Transportation tab.   

We have already seen the Road Status information.   

Cycle Routes can be walked on. 

 

On the Crime and Public Safety tab 

There are lots of crime statistics.   

The Alley gating Orders are closures of footways for safety reasons.  We do not have many.   

 

The Local Government Information tab 

has Parish Boundaries 

 

The Historic Information tab  

has Listed Buildings and Scheduled monuments.   

 

The Thematic Designation Maps tab  

has general regeneration district boundaries.   

 

The Find tab is fairly obvious.  Try some out.   

 

The Tools tab has useful features.   

The Map Grid is for ease of use.   

Grid references can be used to zoom to a point if you know its grid reference.  Six, eight or twelve figure 

numbers can be used.   
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Also the grid reference of a point on the map can be found by the Capture Grid Reference facility.  Click 

Capture Grid Reference and then click at the point of the map.  To get the more familiar 6 figure number 

discard some digits at each end.   

 

The Public Rights of Way Fault reporting is useful.  Click on the Locate Fault and then the place on the 

map.  You can fill in the details.  Normally your Group Footpath Secretary prefers to submit reports so that a 

record can be kept.   

 

The Print/Save Map tool can be accessed here or from direct link at top right hand corner above the map.   

Make sure that the map in the box is what you want to save and enter a title for your reference.  Then click 

either Print or Save. The map is converted into a digital form and there is a sound when it is done.  Use the 

commands on your normal web browser tool bar to either Print or Save.  But be careful to first look at the 

image in Print Preview and turn to Landscape format.  If that is OK then Print or Save As as normal.  You 

have an option of the format as either .bmp or png.  The former is possibly better.   

 

The Draw tab can be used for various functions and is self explanatory.  I find that the printout of your 

drawings does not reproduce dashed or dotted lines.   

 

Results are not very interesting.   

 

Help can be useful.   

 

 

One more thing.   

On the top row of tabs where you zoom in etc there is a direct link to Street View, which is Google Maps 

where you can see the view from the map point.   

 

 

LESSON 3 

 

Other Sources for Maps 

 

MAGIC 

MAGIC is another good resource.   

http://magic.defra.gov.uk/ 

This is the government GIS map.  It contains official stuff for all the country.   

Get Started and read and sign the agreement.   

Zoom the map using the + and – buttons and move the map with a click and drag.   

 

The most useful category is Access which contains National Trails, National Cycle Trails, English Coastat 

Trail (or its probable location), Town and Village Greens etc., Country Parks, Registered Common Land, 

CROW Access areas.   

 

Designations include AONBs and NPs and various nature designations.  At the bottom are various other 

Historic designations.   

http://magic.defra.gov.uk/
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Land –Based Schemes include Agri-Environment schemes and Forest and Woodland Schemes so you can 

tell who is getting public money.   

 

Landscape gives geology, soils and landscape types.   

 

There are Drawing and Printing Facilities.   

 

 

OTHER SOURCES OF MAPS 

MARIO is very convenient to look at the state of the countryside from the OS First Edition but there are 

other maps available which show the terrain with different emphasis.   

 

A good Lancashire resource is the LCC:   http://www.lancashire.gov.uk/environment/oldmap/index.asp 

Yates 1786 is the first to show reasonable roads so look for maps later than this.  

The OS maps are like on MARIO but with some towns at larger scales.  The Caton Tithe Map shows what 

might be available on tithe maps.   

 

The next local resource is Lancaster University Library: 

http://lancaster.libguides.com/search.php?iid=1369&gid=0&c=0&search=maps 

The Lancashire maps stop a bit too early for any detail.   

The Lancaster and Morecambe sections may help close to town.   

The Digital Map Resources gives good links to various repositories such as these below.   

 

A good free collection of collections.  Bias towards large country maps, but good automatic links to other 

collections.  http://project.oldmapsonline.org/ 

 

A commercial source is Old-Maps .co.uk.  http://www.old-maps.co.uk/index.html 

Put in a place name or coordinates and maps appear and can be changed.   

Gives a good idea of a lot of maps but for high resolution you must buy a copy. 

 

An easy to use site for OS maps is the National Library of Scotland.   

http://maps.nls.uk/series/index.html  Just look around for England.  The main advantage of this site is that 

the individual map sheets join nicely and the resolution is high.   

 

For some less usual maps try http://www.visionofbritain.org.uk/maps/    which has War Office Maps and 

Land Utilisation maps.   

 

http://www.genuki.org.uk/big/eng/LAN/Maps.shtml   has material biased towards family history.   

 

If this on-line study whets your appetite then you need to look in person at the Lancashire Archives in 

Preston.   

http://new.lancashire.gov.uk/libraries-and-archives/archives-and-record-office.aspx 

It has all sorts of local maps with ready access and many more local maps such as Estate Maps on request.   

 

http://www.lancashire.gov.uk/environment/oldmap/index.asp
http://lancaster.libguides.com/search.php?iid=1369&gid=0&c=0&search=maps
http://project.oldmapsonline.org/
http://www.old-maps.co.uk/index.html
http://maps.nls.uk/series/index.html
http://www.visionofbritain.org.uk/maps/
http://www.genuki.org.uk/big/eng/LAN/Maps.shtml
http://new.lancashire.gov.uk/libraries-and-archives/archives-and-record-office.aspx
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The National Archives at Kew, http://www.nationalarchives.gov.uk/, has a lot; but not much local material 

has been digitised.  So this requires a search of their holdings, an order and a day out.   

 

BKJ May 2015 

http://www.nationalarchives.gov.uk/

